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About This Guide

Introduction

The purpose of this documentation is to briefly describe how to install the 
components of Novell® BorderManager™ Authentication Service, and how to 
perform basic setup and configuration. In addition, this documentation refers 
you to specific online documents for more information.

The audience for this documentation is network administrators. This 
documentation is not intended for users of the network.

User Comments

We are continually looking for ways to make our products and our 
documentation as easy to use as possible.

You can help us by sharing your comments and suggestions about how our 
documentation could be made more useful to you and about inaccuracies or 
information gaps it might contain.

Submit your comments by using the User Comments form provided with the 
online documentation or by writing to us directly at the following address:

Novell, Inc.

Documentation Development MS PRV-C231

122 East 1700 South

Provo, UT 84606 USA

We appreciate your comments.
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1 Installing Novell BorderManager 
Authentication Service

Use the following checklist to help you install and configure Novell® 
BorderManager™ Authentication Service:

 ❏ Verify the system configuration

❏ Install the Support Pack 5 software on a NetWare® 4.11 server

❏ Install the BorderManager™ Authentication Service software

❏ Access the online documentation

Refer to Novell BorderManager Authentication Service Planning if you are not 
familiar with the RADIUS protocol or remote access configuration.

Verifying the System Configuration

Before you install Novell BorderManager Authentication Service, verify the 
system configuration for each component of the service:

◆ Remote Authentication Dial In User Service (RADIUS) server

◆ Network access server

◆ Administration workstation

RADIUS Server Requirements

The RADIUS server must meet the following requirements:

 ❏ One of the following network operating systems is installed and 
functioning:

◆ NetWare (version 4.11 or later)

◆ Windows NT* (version 4.0 or later)
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❏ 1 MB of free disk space

❏ 1 MB of free memory

❏ TCP/IP configured and functioning

❏ Support Pack 5 for NetWare servers

❏ Novell client software installed and functioning on Windows NT 
servers

Network Access Server Requirements

The network access server must meet the following requirements:

 ❏ RADIUS compliant (IETF RFC 2138 and RFC2139 for accounting 
support)

❏ TCP/IP configured and functioning

❏ RADIUS authentication enabled

❏ RADIUS server address set to either the NetWare 4.11 server or 
Windows NT server on which the RADIUS server software will be 
installed

❏ RADIUS secret established and known

The RADIUS secret should be a random string of 20 to 30 alphanumeric 
characters. The secret is used to protect authentication information sent 
across the network.

Administration Workstation Requirements

The administration workstation must meet the following requirements:

 ❏ Windows 95* or Windows NT 4.0 installed and functioning

❏ Novell client software for Windows 95 or for Windows NT installed 
and functioning

❏ NetWare Administrator utility installed and functioning
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❏ 2 MB of free disk space

Installing Support Pack 5

You must install Support Pack 5 on your NetWare® 4.11 server before you can 
install Novell® BorderManager™ Authentication Service for the first time. 

To install Support Pack 5 from a CD-ROM drive, complete the following steps:

 1. From the administration workstation, log in as a user with 
administrator rights to the server on which BorderManager 
Authentication Service will be installed.

2. Verify that the SYS: volume of this server is mapped to a drive 
on the administration workstation.

3. Copy the SUPPACK5 directory and its contents from the CD-
ROM to the mapped drive.

4. At the NetWare server console prompt, enter 

LOAD INSTALL

5. Select Product Options > Install A Product Not Installed.

6. Press F3.

7. Replace A:\ with SYS:\SUPPACK5 and press Enter.

8. Follow the online instructions to complete the installation.

9. After the installation is complete, press Enter to exit the 
installation and press Esc to return to the Installation Options 
menu. 

10. Select NCF Files Options > Edit Startup.NCF.

11. If necessary, specify the correct path to the directory that 
contains the SERVER.EXE file, then press Enter.

12. Add the following SET commands to the STARTUP.NCF file:

SET MINIMUM PACKET RECEIVE BUFFERS=500
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SET MAXIMUM PACKET RECEIVE BUFFERS=1000

13. Press F10 to save the file and select Yes to confirm.

14. Exit the install utility.

15. Enter the following commands to restart the server:

DOWN

RESTART SERVER

Installing Novell BorderManager Authentication Service

The Novell® BorderManager™ Authentication Service setup program 
performs the following:

◆ Copies the RADIUS server files to the designated NetWare® server or 
Windows NT server

◆ Copies the client files for use by NetWare Administrator to the 
administration workstation

◆ Updates the schema of the NDS™ tree with the new dial access object 
classes and attributes

To install the BorderManager™ Authentication Service software from a CD-
ROM drive, complete the following steps:

 1. From the administration workstation, log in as user with 
administrator rights to the server on which BorderManager 
Authentication Service will be installed.

2. Verify that the SYS: volume of this server is mapped to a drive 
on the administration workstation.

3. Change the current directory to \BMAS on the CD-ROM drive.

4. Run SETUP.EXE.

5. Click Next.

6. Read the license agreement and click Yes if you agree.
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7. Select Standard Setup or Custom Setup.

Standard Setup installs the administration and server files, as well as 
extends the NDS schema. This is the default and the recommended 
choice. If you selected Standard Setup, go to Step 9.

Custom Setup allows you to select which components to install.

8. If you selected Custom Setup, select the components you 
want to install. Click Next.

9. Insert the license diskette or select the directory path where 
the licenses are located.

10. Browse and select the NDS tree where BorderManager 
Authentication Service will be installed.

11. Select the destination directory for the administration files. 
This should be the same directory that contains the NetWare 
Administrator executable file (Windows 95 or Windows NT). 
Click Next.

 The typical destination directory for Windows 95 is SYS:\PUBLIC\WIN95. 
The typical destination directory for Windows NT is SYS:\PUBLIC\WINNT. 

12. Accept the default program folder to add program icons or 
select from Existing Folders. Click Next.

13. Browse and select the NetWare server or Windows NT server 
on which you want to install the RADIUS server files. Click 
Next.

 If you want to use a Windows NT server as an administration workstation, 
select Custom Setup to install the RADIUS server files to a NetWare 
server. 

14. If you selected a Windows NT server, accept the default 
destination to copy RADIUS server files or browse and select 
the destination directory.

15. Verify that the installation information is correct. If you want 
to make changes, click Back. If the installation information is 
correct, click Next.
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16. Click Finish and continue to Chapter 2, “Setting Up Novell 
BorderManager Authentication Service,” on page 9 to create 
a Dial Access System object.

Accessing the Online Documentation

After you have installed the Novell® BorderManager™ Authentication 
Service software, you can either view the online documentation from the CD-
ROM or install the online documentation to a selected directory.

Viewing the Online Documentation from CD-ROM

If you already have Netscape* Navigator* (version 4.0 or later) installed on 
your computer, you can view the BorderManager Authentication Service 
online documentation from the CD-ROM.

To view the online documentation from the CD-ROM, complete the following 
steps:

 1. Change the current directory to \NOVDOCS.

2. Run VIEWDOC.EXE.

Installing the Online Documentation from CD-ROM

You can install the online documentation to a selected directory. If you do not 
have Netscape Navigator (version 4.0 or later) installed on your computer, you 
can install the Web browser software with the Adobe* Acrobat* and Novell 
Knowledge Server utilities. 

To install the BorderManager Authentication Service online documentation 
and Web browser software from the CD-ROM, complete the following steps:

 1. Change the current directory to \NOVDOCS.

2. Run RUNME.EXE.

3. Click Install Documentation.

4. Read the Welcome message. Click Next.
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5. Browse and select a destination folder or accept the default 
and click Next.

6. Select the language to be installed. Click Next.

7. Review the choices you made for the destination folder and 
installed language. To change the choices, click Back. To 
accept the choices, click Next.

8. Click OK to install the Novell Knowledge Server utility.

9. Read the Welcome message. Click Next.

10. Click Yes to install the Netscape browser software if it is not 
already installed on your computer. Follow the prompts to 
install the software. If the Netscape browser software is 
already installed, click OK to add a bookmark for Novell 
documentation.

 Do not automatically restart your computer when prompted during the 
installation of the Netscape browser software. You will be prompted to 
manually restart your computer at the end of the Novell documentation 
installation.

11. Click Yes to install the Adobe Acrobat utility software if it is 
not already installed on your computer. Follow the prompts to 
install the software.

12. Click Next to install the Novell Knowledge Server utility 
software. 

13. Browse and select the location of your Web browser software. 
Click Next.

 Netscape browser software (version 4.0 or later) is required to search and 
print the BorderManager Authentication Service documentation.

14. Review the choices you made for the BorderManager 
Authentication Service documentation. To change the 
choices, click Back. To accept the choices, click Next.

15. Click Finish to exit the installation program.

16. Restart your computer to complete the installation.
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2 Setting Up Novell BorderManager 
Authentication Service

After you have installed the Novell® BorderManager™ Authentication 
Service software and licenses, use the following checklist to configure your 
NDS™ tree for dial access services:

 ❏ Create a Dial Access System object in your NDS tree

❏ Create a Dial Access Profile object in your NDS tree

❏ Set up a user for dial access services

❏ Start the BorderManager™ Authentication Service server

❏ Test your BorderManager Authentication Service configuration

Refer to Novell BorderManager Authentication Service Planning if you want 
information about planning your BorderManager Authentication Service 
implementation.

Creating a Dial Access System Object

The install utility installs the RADIUS server software on a NetWare® or 
Windows NT server in an NDS™ tree. The Dial Access System object stores 
configuration information for RADIUS servers and can manage a common 
configuration for a collection of RADIUS servers working together. You must 
create at least one Dial Access System object in the NDS tree where your 
RADIUS server resides. All participating RADIUS servers use the Dial Access 
System object for configuration. The information stored in the object includes 
the following:

◆ Client configuration—Allows you to define IP addresses for the network 
access servers and the shared secrets used among the RADIUS servers, 
network access servers, and proxy RADIUS servers from which requests 
will be received.
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◆ Proxy targets—Allow you to configure other RADIUS servers to which 
you want to forward RADIUS requests.

◆ Password policy—Allows you to define a password policy for the Dial 
Access System.

◆ Lookup context—Defines the search path for objects.

 Typically, only one Dial Access System object is accessed by all users.

To create a Dial Access System object, complete the following steps:

 1. From the administration workstation, run NetWare® 
Administrator.

2. Select the Organization or Organizational Unit object where 
you want to place the Dial Access System object.

3. Select Create from the Object menu.

The New Object dialog box appears.

4. Select Dial Access System. Click OK.

5. Enter the name for the Dial Access System object. Click 
Create.

6. Double-click the Dial Access System object you just created.

The Dial Access System dialog box appears.

7. Select Clients.

8. Select Add.

The Configure Client dialog box appears.

8a. Enter the IP address of the network access server in the 
Client Address field.

8b. Select Client Type (default: Generic RADIUS).

8c. Enter the RADIUS secret. Reenter the secret.

The RADIUS secret should be a random string of 20 to 30 
alphanumeric characters. The secret is used to protect 
authentication information sent across the network.
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8d. Check Add Another Client if you want to add another 
network access server after you created this one. Leave 
this check box unchecked if this is the last (or only) 
RADIUS client that you will create.

8e. Click OK.

9. Select Password Policy.

10. Select a password policy from the list.

11. Select Lookup Context if you want to use a common name 
login.

11a. Select Add. 

11b. Browse and select the name context.

11c. To add another search context, check Add Another 
Context.

11d. Click OK.

12. Select Miscellaneous.

13. Select Change Dial Access System Password.

The Change Dial Access System Password dialog box appears.

13a. Enter the new password.

The Dial Access System password is used to generate encryption 
keys that protect passwords and secrets. Therefore, we recommend 
that the Dial Access System password be a random string of 20 to 
30 alphanumeric characters. The password is required to start the 
service.

13b. Reenter the new password and click OK.

14. Click OK from the Change Dial Access System dialog box.

15. Click OK from the Dial Access System dialog box.

You are now ready to create a Dial Access Profile object.
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Creating a Dial Access Profile Object

Each Dial Access Profile object defines common attributes of a service used by 
one or more dial-in users. This simplifies administration by eliminating the 
need to configure the attributes of each user. You can define as many profiles 
as required to define different services. For example, you can create a Telnet 
profile that enables users to connect a terminal server to a host. You can also 
create a Telnet profile that enables users to connect to a host using a terminal 
or a terminal emulation program.

The Dial Access Profile object contains a list of RADIUS attributes that specify 
the configuration for creating a specific service.

Creating a Dial Access Profile Object for PPP Service

To create a Dial Access Profile object for PPP Service, complete the following 
steps:

 1. From the administration workstation, run NetWare® 
Administrator.

2. Select or create the Organizational Unit where you want to 
place the Dial Access Profile object.

3. Select Create from the Object menu.

The New Object dialog box appears.

4. Select Dial Access Profile. Click OK.

5. Enter a name for the Dial Access Profile object (such as 
“PPP”). Click Create.

6. Double-click the Dial Access Profile object you just created.

The Dial Access Profile dialog box appears.

7. Select Attributes. Click Add.

The Add Attribute dialog box appears.

7a. Double-click Generic.

7b. Select Service-Type from the Attribute list and select 
Framed in the Value field.
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7c. Select Framed-Protocol from the Attribute list and select 
PPP in the Value field.

8. Select the appropriate attributes from the list. Click OK.

9. Uncheck Add Another Attribute when you have finished 
adding attributes. Click OK from the Edit Attribute dialog box.

10. Click OK from the Dial Access Profile dialog box.

You are now ready to enable users for dial access services.

Creating a Dial Access Profile Object for Telnet Service

To create a Dial Access Profile object for Telnet Service, complete the 
following steps:

 1. From the administration workstation, run NetWare® 
Administrator.

2. Select or create the Organizational Unit where you want to 
place the Dial Access Profile object.

3. Select Create from the Object menu.

The New Object dialog box appears.

4. Select Dial Access Profile. Click OK.

5. Enter a name for the Dial Access Profile object (such as 
“Telnet”). Click Create.

6. Double-click the Dial Access Profile object you just created.

The Dial Access Profile dialog box appears.

7. Select Attributes. Click Add.

The Add Attribute dialog box appears.

7a. Double-click Generic.

7b. Select Service-Type from the Attribute list and Select 
Login in the Value field. 
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7c. Select Login-Service from the Attribute list and select 
Telnet in the Value field.

7d. Select Login-IP-Host from the Attribute list and enter the 
host IP address in the Value field.

8. Uncheck Add Another Attribute when you have finished 
adding attributes. Click OK from the Edit Attribute dialog box.

9. Click OK from the Dial Access Profile dialog box.

You are now ready to enable users for dial access services.

Enabling a User for Dial Access Services

Dial access properties are added to the User object when the Novell® 
BorderManager™ Authentication Service software is installed. The User Dial 
Access Services property page allows you to

◆ Enable a user for dial access services

◆ Select the appropriate Dial Access System for the user

◆ Set the dial access password for the user (if you use separate passwords 
for dial-in users)

◆ Configure or define dial-in services for the user 

◆ Select a default service if a user is configured for more than one dial 
access service

In addition, the Organization and Organizational Unit Dial Access Services 
property pages provide you a way to define default dial access properties for all 
users in the selected container.

 You can specify dial access properties that are unique to a User object on a per-
property basis. This means that a User object dial access setting can override 
the dial access setting of the parent container object, but other settings that are 
not overridden in the User object will always be inherited from the parent 
container object.

To enable a user for dial access services, complete the following steps:
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 1. From the administration workstation, run NetWare® 
Administrator.

2. Select the User object that you want to enable for dial access 
services.

3. Select Dial Access Services.

The Dial Access Services page appears.

4. Select one of the following Dial Access Control settings:

◆ Disable disables dial access services for this user.

◆ Enable enables dial access services for this user.

◆ Use Container Setting specifies that the Dial Access Control 
setting will be inherited from the parent container object.

 You can still specify dial access properties that are unique to a User object 
on a per-property basis when Use Container Setting is selected. Settings 
that are not overridden are always inherited from the parent container 
object.

5. Browse the NDS™ tree and select a Dial Access System 
object.

In most situations, all users select the same Dial Access System object.

6. If the password policy is set to Use Separate Dial Access 
Passwords, complete the following substeps:

6a. Click Set Dial Access Password.

6b. Enter the password. Reenter the password and click OK.

The Set Dial Access Password button might be disabled for one of 
the following reasons:

◆ Use NDS Password is selected in the Dial Access System 
object.

◆ No Dial Access System object is specified for the User object 
or the parent container.

◆ No password is set for the Dial Access System object.
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7. If desired, select additional configured services and the 
appropriate attributes. Click OK twice.

You are now ready to start BorderManager™ Authentication Service.

Starting Novell BorderManager Authentication Service

You should have already performed the following tasks before you start 
Novell® BorderManager™ Authentication Service:

◆ Create a Dial Access System object in your NDS™ tree

◆ Create a Dial Access Profile object in your NDS tree

◆ Enable one or more User objects for dial access services

NetWare 

To start the BorderManager™ Authentication Service program on a NetWare® 
server, complete the following steps:

 1. Enter the following command at the server console for 
BorderManager Authentication Service:

LOAD RADIUS

TCP/IP should already be configured and running.

2. Enter the distinguished name of the Dial Access System 
object.

3. Enter the password of the Dial Access System object.

The following message should be displayed:

RADIUS services initialized successfully.

You are now ready to use BorderManager™ Authentication Service. 

Refer to “Testing Novell BorderManager Authentication Service” on page 18 
if you want to test whether your BorderManager Authentication Service 
configuration is working properly.
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Windows NT

To start BorderManager Authentication Service as a service on a Windows NT 
server, complete the following steps:

 1. Select Settings from the Start menu.

2. Select Control Panel.

3. Double-click Services.

4. Double-click BorderManager Authentication Service.

The Service dialog box appears.

5. Browse and select Administrator in the This Account field 
under Log On As.

6. Enter the Administrator password. Reenter the password.

7. Click OK.

8. Select Programs from the Start menu.

9. Select the BorderManager Authentication Service program 
folder.

10. Select BorderManager Authentication Service SCM.

11. Select Start from the File menu. 

The Start Service dialog box appears.

12. Enter the name of the NDS tree that will be used to 
authenticate users in the NDS Tree field.

13. Enter the name of a user with administrator rights to 
authenticate to the selected NDS tree in the Login Name field.

14. Enter the password for the login name.

15. Enter the distinguished name of the Dial Access System 
object to be used for authentication in the Dial Access 
System field.
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16. Click OK.

You are now ready to use BorderManager Authentication Service. 

Refer to “Testing Novell BorderManager Authentication Service” on page 18 
if you want to test whether your BorderManager Authentication Service 
configuration is working properly.

Testing Novell BorderManager Authentication Service

To determine whether your Novell® BorderManager™ Authentication Service 
configuration is working properly, complete the following steps:

 1. From the administration workstation, run NetWare® 
Administrator.

2. Check that you have a valid Dial Access System object.

3. Create a new Dial Access Profile object.

4. Enter PPP for the Dial Access Profile name. Click OK.

5. Select the newly created PPP Dial Access Profile object.

6. Select Attributes and click Add.

7. In the Attribute field, select Service-Type from the list.

8. In the Value field, select Framed.

9. Uncheck Add Another Attribute. Click OK twice.

10. Select the User object that you want to enable for PPP access.

11. Select Dial Access Services.

12. Select the Dial Access System object that you already 
created.

13. Under Configured Services, select Add.

14. Select the PPP Dial Access Profile object that you already 
created and click OK twice.



 

Chapter 2:  Setting Up Novell BorderManager Authentication Service 19

 
 
 

Novell Confidential

ch_norml.enu   

15. From a dial-in client configured to use PPP, connect to the 
network access server.

16. When prompted for a username, enter the distinguished 
name of the newly enabled User object, for example, 
.eric.acme.

17. Enter the password for the user.

18. Check the dial-in client to see whether it has access to the 
network.
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